Home Health Assessment Validation and Entry System (jHAVEN)

User Guide

In Support of Software
Version 1.1.0
October 01, 2015
# Table of Contents

NAVIGATION TIP: To navigate directly to a specific section listed in the Table of Contents, hold down the CTRL key while clicking on the page number of that specific section.

## Introduction .................................................................................................................. 5
- OASIS ................................................................................................................................. 5
- HAVEN/jHAVEN ................................................................................................................ 5

## General JHAVEN Information ....................................................................................... 5
- Installation .......................................................................................................................... 5
- New JHAVEN Installation Guide .................................................................................... 6
- Initial Setup Login ........................................................................................................... 6
- Accessibility ..................................................................................................................... 6
- JHAVEN User Roles ......................................................................................................... 7
- Access to the Menu Bar ................................................................................................ 8
- Migration Tool ............................................................................................................... 9

## Opening the JHAVEN Application .................................................................................. 9
- Access JHAVEN ............................................................................................................... 9
- Possible Error Message .................................................................................................. 10
- Login Pop-up Window .................................................................................................... 11
  - Initial Setup Login (Default User Login Only) .............................................................. 11
  - JHAVEN User Roles - First-time Login ...................................................................... 11
  - JHAVEN User Roles - Subsequent Logins ................................................................. 13
- The Initial JHAVEN Application Screen ....................................................................... 13
- Home Tab on Welcome Screen .................................................................................... 14
- Home Tab Default ......................................................................................................... 14
- Available Hyperlinks Per Home Tab by User ID .......................................................... 14
- Navigating the Initial JHAVEN Screen ......................................................................... 16

## JHAVEN Assessment Validation & Data Entry ............................................................... 18
- General Assessment Information .................................................................................. 18
- Data Entry Field Types ................................................................................................ 18
- Data Entry Edits ............................................................................................................ 21
- Enforcement ................................................................................................................ 23
- Types of Sequencing .................................................................................................... 23
- RFA Record Sequencing Rules .................................................................................... 24

## JHAVEN User Tool Search ............................................................................................ 24
- Assessment Search ....................................................................................................... 25
- Initiate the Search .......................................................................................................... 25
- Use No Criteria ............................................................................................................... 25
- Use Specific Criteria ..................................................................................................... 26
- Search Summary Result ............................................................................................... 27
- Assessment Search for Only One Specific Patient .................................................... 28
- Branch AND Patient Searches ................................................................................... 28

## Master Data (Administration Screens) ........................................................................ 29
- Administration Screens – Common Features ............................................................... 29
- Title Bar ......................................................................................................................... 29
- Menu Bar ....................................................................................................................... 29
- Tool Bar ......................................................................................................................... 29
- Administration Screen Tabs ....................................................................................... 30

## Agency Screen – Add & Maintain an Agency ................................................................. 32
IMPORT DATA FROM OUTSIDE SOURCE ................................................................. 75

JHAVEN APPLICATION REPORTS ............................................................................. 79
  Report Viewer ........................................................................................................ 79
  Print Report ........................................................................................................... 79
  Save Report ............................................................................................................ 79
  Export Report ........................................................................................................ 79
  Available jHAVEN Reports ..................................................................................... 80
  Event tracking Reports .......................................................................................... 80
  Assessment Data Entry – By Status Report ............................................................. 86
  Assessment Data Entry – By Branch Report ........................................................... 87
  Data Comparison Report ........................................................................................ 89

CLOSING THE APPLICATION ..................................................................................... 92
  Session Time Out ..................................................................................................... 92
  Save Resources Pop-up Window .............................................................................. 92
  Logout ....................................................................................................................... 93
  Exit ......................................................................................................................... 93
  Data Backup on Close ............................................................................................. 94

SECURITY ................................................................................................................. 95
  Change Security Answers ....................................................................................... 95
  Change Password .................................................................................................. 96
  Logout ..................................................................................................................... 97

HELP ....................................................................................................................... 97
  Help Option from Menu Bar .................................................................................. 98
  Help Search .......................................................................................................... 98
  Help Contents ....................................................................................................... 100
  About Quality Management System ..................................................................... 102

MISCELLANEOUS SYSTEM MAINTENANCE ......................................................... 103
  Passwords ............................................................................................................ 103
    Password Rules .................................................................................................. 103
    Forgotten Passwords ............................................................................................ 103
  Locked Accounts ................................................................................................... 104
    Data Entry User & View Only User Account Locked ....................................... 104
    System Administrator Account Locked ........................................................... 104
  Database Backup and Restore .............................................................................. 105
    Database Backup ............................................................................................... 105
    Changing the Backup File Location .................................................................. 105
    Restore the Database from Backup .................................................................... 105

NETWORK CLIENT/SERVER APPLICATION INSTRUCTIONS ............................. 107
  Unlock Client/Server Records ............................................................................... 107
  Unlock using Assessment Search Screen .............................................................. 107
  Unlocking Records using the Locked Pop-up Window .......................................... 108

END OF USER GUIDE .............................................................................................. 110
Introduction

OASIS

The Outcome Assessment Information Set (OASIS) was developed by the Centers for Medicare & Medicaid Services (CMS) to set a standardized protocol for assessing the clinical characteristics of Home Health Agency (HHA) patients. This information is used to better support the regulatory process and policy-making by providing survey agencies with a mechanism for objectively measuring Agency performance and quality. It also is used to support a prospective payment system for HHAs. In addition, it provides researchers with a rich set of information to support the development of improved standards of care through the study of patient care outcomes.

The purpose of the OASIS National Automation Project is to provide computerized storage, access, and analysis of the OASIS data on HHA patients across the U.S. The OASIS System consists of several interrelated components, including data communications and an OASIS National Data Repository. It is intended to create a standard, nationwide system for connecting HHAs to their respective State agencies for the purpose of electronic interchange of data, reports, and other information.

For more detail, go to the CMS website:

HAVEN/jHAVEN

To achieve their goals, CMS has sponsored the development of a data entry system known as the OASIS Home Assessment Validation and Entry (HAVEN) System. The new version will be jHAVEN, converted to use Java. HHAs can use jHAVEN for collecting OASIS data in a standardized format and electronically creating OASIS data records to be sent directly into the ASAP system.

Three (3) OASIS Data Specifications are used in jHAVEN.

2.10: Data specs V2.10: effective for records with effective dates from 01/01/2010 through 12/31/2014
2.11: Data specs V2.11: effective for records with effective dates from 01/01/2015 to 09/30/2015
2.12: Data specs V2.12: effective for records with effective dates on or after 10/01/2015

jHAVEN is designed to work with external screen reader software (e.g., JAWS) for compliance with Section 508. At the login screen, users have the checkbox option to select “Enable Accessibility Feature”. This option should be checked when an external screen reader will be used.

General jHAVEN Information

Installation

jHAVEN may be used as a standalone application or in a network configuration.

- A standalone installation is used on an independent user workstation.
- A network installation is intended to be used for a group of users with a designated database server in a separate location.
New jHAVEN Installation Guide

Installation instructions, with Hardware/Software Specifications, are located in the “jHAVEN Installation Guide”. A copy of this guide may be found on the following websites:

- The CMS Website: [https://www.qtso.com/cmslinks.html](https://www.qtso.com/cmslinks.html)
- The QTSO Website: QIES Technical Support Office - jHAVEN Download

Initial Setup Login

For initial login, using the default User ID, please consult the jHAVEN Installation Guide. That is the guide, which details the Initial Setup Login process.

After the initial Login is completed, the default user must add an agency and the first System Administrator. See the TOC to locate the following detail sections.

- Agency Screen – Add & Maintain an Agency
- User Screen – Add & Maintain a User

Accessibility

Selecting the ‘Enable Accessibility Features’ check box at the bottom of the login screen will turn on accessibility features for users requiring assistive technology (e.g. screen readers).

By default, the ‘Enable Accessibility Feature’ check box will be checked the first time the Login pop-up displays. This checkbox being checked indicates Accessibility features are turned on.

The User may determine whether they wish to use the accessibility features by either checking or unchecking the check box. The check box will remain checked, or unchecked, until changed by the user when the user logs into the application again.

The “Welcome to jHAVEN” pop-up window for Accessibility displays the following.

“This is the Welcome message for jHAVEN. After closing this dialog box, press the ALT key to enable the drop down menu to perform jHAVEN administration activities and assessment entry. Use CONTROL + Page Up and CONTROL + Page Down to switch between open screens. Press ALT + J to get additional information about that window. Currently, the screen that is open is used to detail the various sections of jHAVEN. It consists of multiple sections, each with a button to take the user to the section described.”
If the user chooses to use the accessibility features, the Accessibility icon will display in the tool bar on screens within jHAVEN. The user can either click on the icon or use ALT+J to open the accessibility screens.

These informational pop up screens explain the layout of the open screen and provide shortcut key-board combinations to move the cursor around the page. For example, ALT+1 on the Agency screen will move the cursor to the beginning of the agency data entry section. When the cursor is on an arrow beside a field, the space bar will expand/collapse a section of data.

NOTE: When using key combinations such as ALT+1, the numbers across the top of the keyboard should be used rather than the numeric keypad.

**jHAVEN User Roles**

The User Roles available in jHAVEN include:
- System Administrator
- Data Entry
- View Only

The specific User Role assigned to a user determines what functionality is available to that user.

Sample below illustrates the access available under the ‘File” menu item with an active Agency screen for the three (3) jHAVEN User Roles and matches up with the table below.

To enhance security of data in the application, each user type has a different level of access.
1. All Users will have the Accessibility option if Accessibility is turned on.
2. The System Administrator user has access to add new, delete existing and modify any agency records.
3. The Data Entry user may view, open, update and close the agency record with which they are associated.
4. The View Only user has no access to the agency records.
5. All Users will be able to Exit the tool.
The following table provides a summary of the valid user roles and their access rights within the jHAVEN tool. Access is listed by Menu Options based on which screen is active.

**Access to the Menu Bar**

The following tables document the jHAVEN access by User Roles and Screen Menu Dropdown and/or Application Screens.

Table Legend:
- ‘Yes’ indicates that the Menu Item is available AND the Option is in the dropdown, therefore available.
- ‘No’ indicates that the Menu Item is available, BUT the Option is NOT in the dropdown, therefore unavailable.
- Dash (-) indicates that the Menu Item is NOT available to the user and therefore there will not be a dropdown with Options.

<table>
<thead>
<tr>
<th>Menu Option</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>Sys Adm</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>Alt+F</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Administration</td>
<td>Alt+A</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Import/Export</td>
<td>Alt+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Import</td>
<td>Ctrl+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Export</td>
<td>Ctrl+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Reports</td>
<td>Alt+R</td>
<td>-</td>
<td>Yes</td>
<td>Limited</td>
<td>Limited</td>
<td>Yes</td>
</tr>
<tr>
<td>Security Menu</td>
<td>Alt+U</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Assessment</td>
<td>Alt+M</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Help Menu</td>
<td>Alt+H</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Footnotes:
- ¹ Alt Keys are valid only if that user has access to that function.
- ² Under the File Menu item, only those menu options available to that user, will have icon(s) in that user's tool bar. If the option is not available to user, then the icon will not appear in the user's tool bar.

**Exception:** 'Save All' and 'Change Backup File Location' are only available in the File Menu; NOT on the Tool Bar.
Migration Tool
The process steps for utilizing the Migration Tool are covered in the “jHAVEN Migration Guide”.

Opening the jHAVEN Application
Access jHAVEN
Once jHAVEN has been installed and the ‘initial setup’ has been successfully completed, access the program using one of the following methods.

Start menu All Programs – click the jHAVEN folder in the start menu to list the available links:
- jHAVEN User Guide
- jHAVEN
- Uninstall
- www.cms.gov
- www.qtso.com

Desktop ICONs – double click the icon found on the desktop.

NOTE: Only one of these ICONs will be on the desktop.

From the Installation Folder – navigate to the folder where jHAVEN was installed, double click the jHAVEN.exe file.
The jHAVEN splash screen displays momentarily.

The Welcome to jHAVEN screen displays while the program is loading. This may take a few minutes and requires no response from the user.

The welcome tab on the Welcome screen can be closed by clicking the white ‘X’ that appears after the tab title “Welcome”. This may only be done if the Login pop-up window has not yet been displayed.

**Possible Error Message**

Only one copy of installation of jHAVEN may be running at one time.
Login Pop-up Window

The title bar of the login screen will include the User Tool acronym (jHAVEN) and software version number (1.x or 1.x.x). Accessibility can be turned off on this pop-up window by removing the check in the checkbox. If the check is left, then Accessibility will be turned on. For more details see Accessibility.

Initial Setup Login (Default User Login Only)

For the initial login as a ‘default user’, please consult the jHAVEN Installation Guide for details on how to complete the Initial Setup Login process.

jHAVEN User Roles - First-time Login

Complete the following steps to login to jHAVEN for the first time.

1. In the User ID field, enter the User ID, which was assigned by the System Administrator.
2. Enter this same User ID into the Password field.

   NOTE: The User ID and Password are case sensitive.

3. Click Login.
   a. The ‘Change Password’ screen displays. Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:
      i. “The new password and the confirm new password must match.”
      ii. “The new password must be at least 8 characters long.”
      iii. “The new password must be no more than 20 characters long.”
      iv. “The new password must not contain any space.”
      v. “The new password must not contain the User ID, First Name, Last Name, or Email.”
      vi. “The new password must not begin with a number.”
      vii. “The new password can only contain a maximum of 3 repetitive characters.”
      viii. “The new password must contain at least one for each of the following type of characters.”
         ix. “Upper-case Character: A-Z”
         x. “Lower-case Character: a-z”
         xi. “Number: 0-9”
         xii. “Special Character: - &~!*@#$%^*()_+-={}|;:'"<>?,.?/”
         xiii. “The new password must not match any of the user’s most recent 6 passwords.”
         xiv. “The new password will be set to expire in 60 days.”
4. Enter a new password in the New Password and Confirm New Password fields. These must be identical.

5. Click the ‘Continue’ button to complete the login process.

   NOTE: When Cancel is clicked, then another Change Password pop-up comes up with the following message: “You must change your password before accessing the system. If you do not change the password, you will be logged off the system”. Clicking the ‘Cancel’ button on this pop-up takes the user back to the previous Change Password pop-up. Clicking OK takes the user to the login screen.

6. The Security Questions screen displays. It is required that the user respond to at least six (6) of the ten security questions listed.
   a. “What city were you born in?”
   b. “What year did you graduate from high school?”
   c. “What is your favorite sport?”
   d. “What was the make of your first car?”
   e. “What was the color of your first car?”
   f. “What is your mother’s maiden name?”
   g. “What was the name of your first pet?”
   h. “What size shoe do you wear?”
   i. “What is your favorite season of the year?”
   j. “What is your favorite movie?”
Note: The user must tab forward after entering their last answer, in order to enable the “OK” button.

7. Click OK.
   The jHAVEN screen displays.
8. Continue on with The Initial jHAVEN Application Screen

jHAVEN User Roles - Subsequent Logins
Complete the following steps to login to jHAVEN if this is NOT the first time doing so AND you have set up your password successfully.
   1. Enter the User ID assigned by the System Administrator user, in the User ID field.
   2. Enter the Password you have created into the Password field.

   NOTE: The User ID and Password are case sensitive.

   3. Click Login.
   4. The jHAVEN application screen displays.
   5. Continue on with The Initial jHAVEN Application Screen

The Initial jHAVEN Application Screen
When the user has successfully logged in, the application screen displays what will be available based on the User Role accessing the Menu items
   1. The Default User will have access to the Menu Bar items: File, Administration, Security, and Help.

   NOTE: See the Installation Guide for the default users access and initial setup.
1. The System Administrator will have access to the Menu Bar items: File, Administration, Import/Export, Reports, Security, Assessment, and Help.

2. Data Entry User will have access to the Menu Bar items: File, Administration, Reports, Security, Assessment, and Help.

3. View Only User will have access to the Menu Bar items: File, Reports, Security, Assessment, and Help.

NOTE: The specific User Role assigned determines what functionality is available to that user. See User Roles Access Table above for details of this access.

6. Continue on to the next section.

**Home Tab on Welcome Screen**

The first screen to be displayed is the jHAVEN Application Welcome screen. This screen will contain the Home Tab by default, which is dynamic based on the User’s assigned User ID.

**Home Tab Default**

At the bottom of the Home tab, there is one “Do not display this home screen after logging into the application.” check box. The default is the check box will be initially unchecked; indicating to display the Home tab each time the user successfully logs into the application.

The User may check the check box. When this is done, this screen will not continue to display. If the Home Tab is not being displayed, it can be re-displayed using the Help Menu Item; See the drop down list.

NOTE: The Home tab setting is unique to each user, and remains unchanged until the user changes it using the check box. This is true even when the software is upgraded; the settings will remain the same.

**Available Hyperlinks Per Home Tab by User ID**

All the User Roles will initially have access to their own User Role Home tab. These vary by User Role, but are similar in format.

**Default User**

See the jHAVEN Installation Guide for the details for the ‘default users’ Home tab.

**System Administrator**

After the System Administrator is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.

The System Administrator will have access to the Menu Bar items and their drop down options: File, Administration, Imports/Exports, Reports, Security, Assessment, and Help.
The Home tab is displayed. The “Go To” action buttons for the System Administrator will be: Agency, Branch, User, Patient, Assessment, Import/Export, Reports, Enforcement and User Guide.

**Data Entry User**

After the Data Entry User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.

The Data Entry User will have access to the Menu Bar items and their drop down options: File, Administration, Reports, Security, Assessment, and Help.
The Home tab is displayed. The “Go To” action buttons for the Data Entry User will be: Agency, Branch, Patient, Assessment, Reports, and jHAVEN User Guide.

**View Only User**

After the View Only User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.

The View Only User will have access to the Menu Bar items and their drop down options: File, Reports, Security, Assessment, and Help.

The Home tab is displayed. The “Go To” action buttons for the View Only User will be: Assessment, Reports, and jHAVEN User Guide.

**Navigating the Initial jHAVEN Screen**

The ‘Go To’ Action buttons are used to navigate directly to an application screen, pop-up window, or the User Guide. Each button has verbiage to indicate how it is to be used. Examples using the Home Tab Buttons for navigating are the following sub-sections.

**Navigating to the Agency Screen**

The following flow is illustrated using the ‘Go To Agency’ button. This hyperlink takes the user directly to the Agency screen. Complete the following steps:

1. Log into the application.
2. Click on the ‘Go To Agency’ button.
3. The Agency screen displays.

![Agency Screen](image_url)

- The Agency screen displays with all of the agency data that is currently available.
b. The user may view and/or manipulate the data as their access allows.

4. Close the Agency screen. If the Agency Screen is the only screen open, then the Home tab will be displayed.

![Image of Agency Information screen]

5. However, if other Administration and/or Assessment screens are open, they will need to be closed for the application to automatically go back to displaying the Home tab.
   a. You may always click on the Home Tab to cause it to be displayed.

   NOTE: If the ‘do not display’ check box, at the bottom of the Home tab, is checked, then the Home tab will no longer be displayed.

**Navigating to a Pop-up Window**

The following flow is illustrated using the ‘Go To Assessment by Status’ button. This hyperlink takes the user directly to the Criteria pop-up window required for the Assessment Data Entry – Status report. Complete the following steps:

1. Log into the application.
2. Click on the ‘Go To Assessment by Status’ button.
3. The Assessment Data Entry – By Status Criteria pop-up window displays.
   a. The Data Fields are all required:
      i. Agency
      ii. Status
      iii. Data Entry Date: From and To

   ![Image of Assessment Data Entry - By Status window]

   b. Select the Agency, Status (or Statuses), and the Data Entry From and To Dates.
   c. Click the ‘OK’ button.

4. The Criteria screen closes and the Report Viewer will display the report.
NOTE: If the ‘do not display’ check box, at the bottom of the Home tab, is checked, then the Home tab will no longer be displayed.

**Navigating to the User Guide**

When the ‘Go To User Guide’ button is used, the .pdf copy of the User Guide for jHAVEN is opened and displayed. If the application cannot find the User Guide where it is expected, the following error message displays.

1. Click the ‘OK’ button.
2. Contact your System Administrator.

NOTE: The User Guide may always be located on the QTSO Website:

https://www.qtso.com/havendownload.html

**jHAVEN Assessment Validation & Data Entry**

**General Assessment Information**

**Data Entry Field Types**

**Text**

Text fields allow data to be entered manually, which adheres to the submission rules (length, alpha, numeric, special characters, etc.) for each specific field. These fields may be required or optional.

If a text field is a required field and nothing is entered into it, and the user tabs past it, a warning message will be displayed.

The following are examples of text fields taken from the patient screen: Patient First Name, Patient Middle Initial, Patient Last Name, Patient Suffix.

**Date**

Date fields are formatted for the entry of a valid date. The date may be entered manually or, if accessibility is turned OFF, by clicking on the calendar next to the date field and selecting a date.
The valid format of all dates will be MM-DD-YYYY.
- Where: MM = Month = 01-12, DD = Day = 01-29, 30, or 31, depending on the month, and YYYY equals the four digit year.

The following is an example of a date field.

**Checkbox**
Check boxes allow the selection of values associated with each box. If the check box is checked the value will be included. If the check box is not checked, it will not be included. The following is an example of this type of checkbox.

**Checkbox used with Other Data Fields**
There are data fields of various types that must have required input. However, at the time the assessment is performed all of this information may not be known. Therefore, a checkbox is provided to indicate that the user has not skipped this item, but, in fact, does not have the information. Thus, ‘required’ data has been provided.

Later in the verification process this may result in an error, which the user must correct by actually supplying the requested data. For Example, they are used here with Text fields.
1. The Medicare Number is not known, the check box is checked.
2. The Social Security Number is also known or available, the check box is checked.
3. The Medicaid Number is known and was entered; therefore the check box below it was disabled.

**Dropdown List**
Dropdown lists contain allowable answers to a specific field. To answer a dropdown question, tab to the field and use the arrow keys on the keyboard to navigate through the answer options. Once the appropriate answer is displayed, use the Tab key to move to the next question. A mouse may also be used to select an answer in a dropdown list. Click the arrow on the right side of the field to expand the list. Click the desired answer. Click the mouse on the next question. The Delete key on the keyboard can be used to clear the field. The following is an example of a dropdown list.
**List Box**
A List Box is a display-only box that the application populates. The first row will contain the field name, plus the field’s M00#, if it exists. The remaining row(s) will be populated with data selected by the User. These List Boxes are most often associated with Grid fields.

**Grid**
Grid buttons are used for selection of one or more values, usually including a large number of selection options. Click on the grid button and a series of pop-up windows containing a list of items from which to choose. The user may select one or more of these items.

Here are examples of the use of the Grid related to the ICD Codes for assessments.

The Grid opens up to an empty selection list. The ‘New’ icon will display a pop-up list of all the appropriate diagnosis codes, from which the user may select the code, or codes, they require.

Note: The User may also enter a data in the ‘Select a Value’ field and do a simple search of this list.
The user may then insert their selection. Errors will be provided as found. Once verified, the pop-up should be closed. The jHAVEN application will then pull the user’s selection(s) into a List Box, which is a display-only field.

This box will be expanded to accommodate multiple selections.

If the user wishes to modify this selection, they must return to the Grid button and repeat the process.

**Data Entry Edits**

*Edits*

Data edits are applied to the fields during the data entry process into jHAVEN.

NOTE: These edits are unique messages to assist users with the accurate completion of data entry. Some will present a pop up message and must be addressed at the time they are displayed in order to proceed. Some edits may not appear until the entry is saved & validated.
The error messages are assigned numbers to aid in trouble shooting. When there are questions about a message, it is beneficial to record the message before calling the Help Desk. This can facilitate quicker answers and/or resolutions.

**Error Messages**
This type of edit message lets the user know information entered is incorrect or missing. It must be corrected or entered before the information will be saved. This is referred to as a “fatal” error.

![Error Message Example]

The ‘X” symbol identifies this message as a Fatal Error Message.

**Warning Messages**
This type of message indicates there is information entered that should be verified as accurate, or serve as a reminder of how some fields should be populated...

![Warning Message Example]

The ‘!” symbol identifies this message as a Warning Message.

**Decision Messages**
This type of message requires a decision on the part of the User. This message may also include additional information to aid the User in their decision. The decision will most often directly affect the process.

![Decision Message Example]

The ‘?” symbol identifies this message as a Decision Message.

**Informational Messages**
This type of message indicates that something may, or has, occurred. These provide additional information about the field or the process.
The ‘I’ symbol identifies this message as an Informational Message.

**Enforcement**

Enforcement of Assessment Sequencing was turned on during installation, as a system default. The System Administrator is the only user who may turn this off and on after the installation has completed successfully and application “start-up” has occurred. Assessment Enforcement sequencing rules are used only in conjunction with adding assessments.

**Types of Sequencing**

There are two (2) types of sequencing: 1) Strong Enforcement and 2) Weak Enforcement.

**Strong Enforcement**

Strong enforcement of assessment sequencing is automatically set when the software is installed. This type of sequencing provides an error whenever a newly added assessment violates the sequencing rules. It prohibits that specific type of assessment from being added.

**Weak Sequencing**

Weak enforcement of the assessment sequencing may be set by the System Administrator after the completion of installation of the software. This type of enforcement provides a warning, which indicates that sequencing is being violated. However, it does NOT prohibit the assessments type from being added.

The following steps should be completed to set the Enforcement switch after installation:

1. Select the Enforcement option from the Assessment drop down on the Menu Bar.

2. The default is ‘Strong Enforcement’.
   a. To switch this over to ‘Weak Enforcement’, uncheck the checkbox in front of “Enable Strong Enforcement”.

3. Click ‘Save’ icon.
4. The Enforcement is reversed.
NOTE: To re-set or reverse Enforcement, re-check the checkbox.

**RFA Record Sequencing Rules**

The sequence of records for a patient must conform to certain requirements. For example, a resumption of care record cannot directly follow a start of care assessment record. The following table indicates allowable sequences of records. In this table, the abbreviation *RFA* is used to represent the “reason for assessment” contained in item M0100_ASSMT_REASON. X’s in the table are used to indicate allowable record sequences.

To understand this table, consider a sequence of records for a particular patient served by a particular home health agency and assume that the records are ordered by effective date as defined above. Let’s suppose a particular record in the sequence is designated *Record A*. If *Record A* is immediately followed by a second record in the sequence (called *Record B*), the table below can be used to determine what RFAs are allowed for *Record B*.

For example, suppose *Record A* has an RFA of 03 (resumption of care after inpatient stay). We can see from the row labeled “03” that there are check marks under RFAs 04 through 09. This means that if a record with an RFA equal to 03 occurs in the record sequence and if it is immediately followed by another record, that record must have an RFA equal to 04, 05, 06, 07, 08, or 09.

<table>
<thead>
<tr>
<th>RFA - Rec A</th>
<th>Rec B - 01</th>
<th>Rec B - 03</th>
<th>Rec B - 04</th>
<th>Rec B - 05</th>
<th>Rec B - 06</th>
<th>Rec B - 07</th>
<th>Rec B - 08</th>
<th>Rec B - 09</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>03</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>04</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>05</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>06</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>07</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>08</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>09</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

In general, the initial record in a sequence of records will have an RFA of 01 (start of care – further visits planned). However, there can be exceptions to this general rule. One example involves patients who turn 18 while under care. For these patients, the HHA is not required to do a start of care assessment, but must instead submit data for the next required comprehensive assessment. Another example occurred when the OASIS electronic submission system was first put in place. Home health agencies were required to submit assessment data for all patients who were currently under care, but the rule requiring an RFA 01 for an initial record was waived for patients who were currently under care on the startup date.

**jHAVEN User Tool Search**

The search feature is available for the following screens:

- Assessment Search Screen
- Branch Screen
- Patient Screen

All these search features function in the same manner. The difference is in how they are initiated.
Assessment Search

Initiate the Search

Select the Search option from the Assessment drop down on the Menu Bar and the Assessment Search Screen displays.

The Assessment Search screen displays.

Use No Criteria

1. If no criteria are to be used, move past the Search Criteria rows, and click the ‘Search’ button.
2. All the Records found in the database will be returned. The exception would be any Patient or Assessment associated with a Patient marked as “Yes, Hide Patient”. These will not be included in the search results.
   a. You can include them when entering criteria: Check the ‘Show Hidden’ Check box.
Use Specific Criteria

1. Enter specific criteria to narrow the search, add it into the Search Criteria rows using Field Name, Condition, and Field Value.
   a. Text Fields:
      i. Fields requiring the User to enter data into the Field Value.
      ii. Conditions for Text fields will be: Contains, Equal To, and Not Equal To.
   b. Fix Value Fields:
      i. Fields requiring the User to select an option for a dropdown for the Field Value.
      ii. Conditions for Fixed Value fields will be: Equal To and Not Equal To.
   c. Date Fields:
      i. Fields requiring the User to enter a date into the Field Value. Conditions for Date fields will be: Equal to, Greater Than, Greater Or Equal To, Less Than, Less Or Equal To, and Not Equal To.

RULES:

1. If one of the criteria fields is used, all three (3) must be used.
2. Text fields and date fields will require the user to enter data into the Field Value field.
3. Fixed value fields will require the user to select a value from a drop down list.

2. Click the Search button.
Note: Clicking the Search button after entering the search criteria will display only the results that match all the search criteria.

**Clear Search Criteria**

Click the Clear button to remove all search criteria.

**Show Hidden**

Selecting the checkbox next to Show Hidden will include assessments for Patients marked ‘Yes, Hide Record’ on the Patient screen. Unchecking this box will eliminate all Patients that have been hidden.

NOTE: The Branch Screen does not contain the “Show Hidden” Checkbox. It is not applicable to the Branch Data.

**Search Summary Result**

The results of the search, whether or not criteria were used, display all the results found. This summary is sorted by the Patient’s Last Name.

The User may resort the summary by clicking on the column headers. In the following example, the summary has been sorted by the ‘State’ column.
Navigating the Search Result Summary

1. Navigating the summary is done using the arrow buttons.

   a. Begin with first 100 rows of data.
   b. Go back one page.
   c. Number of records returned and which are currently displayed in the summary.
   d. Go forward one page.
   e. Go down to the last group of 100 rows in this result.
   f. View All

Assessment Search for Only One Specific Patient

Often it is faster and more efficient to find all the assessments for one single patient. This can be done directly from the Patient Screen using the ‘View Assessments’ feature. For detail how to do this, see section Locate Assessments from the Patient Screen.

Branch AND Patient Searches

The search for the Branch and Patient screens is included in those Administration screens.

- Select the Branch option from the Administration drop down on the Menu Bar and the Branch Screen displays.
- Select the Patient option from the Administration drop down on the Menu Bar and the Patient Screen displays.

These Administration screens include the search in the top portion of each of their screens. The example shown below is using the Patient Screen. The Branch Screen is similar.
Master Data (Administration Screens)

Before any assessments can be created, a basic set of Master Data is required. This data consists of Agency data, User data, Branch data and Patient data. It is entered into jHAVEN via the Administration Screens.

Administration Screens – Common Features

The Administration Screens are used to capture master data. That is, the Agency, Branch, User and Patient data, which will support the Home Health Agency Assessments. jHAVEN contains the following familiar Windows features.

Title Bar
Displays the name of the software, jHAVEN and the software version.

Menu Bar
Drop down lists on the menu bar contain command selections based on user roles and the open screen.

Utilizing the ‘Alt’ key on the keyboard will place the cursor in the menu bar.
By using the arrow keys on the keyboard, users can navigate through the selections on the menu bar.

For example: On the Assessment Search screen, if the cursor is on the File menu item, pressing the right directional arrow will move the cursor to the Administration menu item. Pressing the up and/or down directional arrows will navigate through the drop down menu list.

Tool Bar
Each screen contains a tool bar that displays various buttons and icons to assist the user. Holding the mouse over the icons will display the name of the functionality. The availability of the icons will vary depending upon the user role and the Administration screen displayed (active).
Administration Screen Tabs
Tabs for any open Administration screens will display. An asterisk (*) next to the name on the tab means there are changes that need to be saved.

Various screens are divided into multiple sections. Sections displayed are dependent upon the type of screen.

The Agency screen is divided into:
- Summary
- Detail
- Agent Information

The User screen is divided into:
- Summary
- Detail
- Activation
- Agency
The Branch screen is divided into:

- Search Criteria
- Summary
- Detail
- Contact Person
- Actions

The Patient screen is divided into:

- Search Criteria
- Summary
- Detail
- Actions

Each section can be collapsed, as illustrated in the above screen shots, by use of the arrow to the left of the section title. Clicking on the arrow a second time will expand the section.

Some sections may also be resized if needed by placing the cursor over the line that separates the sections. The cursor will create an arrow. Click and drag the line to either the right or left depending on which area the user wants to expand. Columns in the Summary section can be resized by clicking and dragging on the line between headings.

The Agency screen documents the basic information about the Agency. The jHAVEN tables are now capable of supporting multiple agencies, which are identified as unique entities by using unique Agency IDs plus the Agency State Code.
Agency Screen – Add & Maintain an Agency

Agency Screen – Create An Agency

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The Agency screen allows users, to setup, modify and delete agencies. The term “Agency” refers to a Home Health Agency.

Complete the following steps to create a new Agency.

1. Select the Agency option from the Administration drop down on the Menu Bar.

2. Click ‘Add’.

3. Enter detail agency information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
3. After agency details are entered, click the Save icon.
   a. If Accessibility is on, the Save Agency Options pop-up window displays.
      i. Save and Close
      ii. Save and Continue
      iii. Cancel

4. The Informational Message displays to confirm that the agency has been saved.

5. Saved agency information will display in the Agency Summary section on the left side of the screen.

6. To continue on this screen and add additional agencies, click the New icon.
7. Enter data and click the Save icon.

   NOTE: Edits are performed during the data entry process and, if remain at the time the Agency is saved, the errors are summarized in a pop-up window.

**Agency Screen - Modify an Agency**

Complete the following steps to modify an existing agency.

1. Locate and highlight the agency in the summary section.
2. Make the appropriate changes on the right side of the screen.
3. Click the Save icon.

**Agency Screen – Special Functionality**

**Effects of Modifying the Agency ID Field**

The User may modify the Agency ID in an existing Agency. When this is done through the Agency screen, the following activities occur within all the Administration Screens.

- Any User that has been associated with the original Agency ID will be re-associated with the NEW Agency ID.
- If there are Branches associated with the original Agency ID, the Branch will be re-associated with the NEW Agency ID.
- If there are patients associated with the original Agency ID, those Patients will be re-associated with the NEW Agency ID.
- If there are assessments associated with any patient that has been re-associated with an updated Agency ID, when these assessments are re-opened, a Decision Message will be displayed.

**Agency Screen - Delete an Agency**

Complete the following steps to delete an agency.

1. Locate and highlight the agency in the summary section.
2. Click the Delete icon.

RULES:
1. An Agency cannot be deleted if patients have already been created under that agency.
2. An Agency with no CCN will be rejected by the ASAP system.
3. A Branch is a satellite of an Agency. Any branch must be tied to an agency.

User Screen – Add & Maintain a User

User Screen - Create a User

There must always be at least one active System Administrator. It is highly recommended that there be at least two System Administrators.

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The User screen allows users, based on User Roles Access Table, to setup new users, modify users and delete users. Complete the following steps to add a new user.

1. Select the User option from the Administration drop down on the toolbar.

2. The User screen displays.
3. Click ‘Add’.
4. Enter user information into the User Detail section. Required fields display on the screen in bold type with an asterisk.

5. Enter the Agency Detail. User must select an Agency to which this User will be associated.
6. Branch is not required. However, the user will get a warning message if no branch association is selected.

   ![Agency Detail Image]

   a. Branch Option will be:
      i. [P] = Parent Agency. This user is not associated with a specific Branch, but is associated with the agency (the parent) that was selected.
      ii. [N] = The agency selected has no branches at this time.
      iii. 10-character Branch ID = Specific Branch with an assigned Branch ID, with which the user may be associated.

RULES:
1. The 10-character Branch ID will only be listed under ‘Branch’ if the System Administrator has already entered that Branch into the jHAVEN database.
2. After user information has been entered, click the Save icon. Saved user information will display in the User Summary section on the left side of the screen.
3. To add additional users, click the New icon.
4. Enter data and click the Save icon.

User Screen - Modify a User

Complete the following steps to modify an existing user.
1. Access the User Screen.
   ![User Screen Image]
2. Locate and highlight the user in the summary section.
3. Make the appropriate changes under the User Detail panel, on the right side of the screen.
4. Click the Save icon.
NOTE: The User ID field cannot be modified once the user is saved.

**Termination Date**
A Termination Date should only be entered if an active user is no longer valid (e.g., no longer works for the agency).

**RULES:**
1. A User cannot terminate themselves.
2. A Termination Date should only be entered if an active user is no longer valid (e.g., no longer works for the agency).

If a Termination Date is entered, a Termination Date message box displays advising pending assessments should be reassigned to an active user.

**User Screen - Delete a User**
Complete the following steps to delete a user.
1. Locate and highlight the user in the summary section.
2. Click the Delete icon.

RULE: Deletions cannot be made if user has created or modified any assessments.
Branch Screen – Add & Maintain a Branch

The Branch screen allows users to add, edit, delete and search for Branches. To access the Branch Screen select the Branch option from the Administration drop down on the menu bar.

Branch Screen – Create a Branch

Branches may be added to the jHAVEN application after the Branch ID has been assigned by the CMS State Agency and provided to the Agency. Only System Administrators may add Branch records. Complete the following steps to add a new Branch:

1. Display the Branch Screen.
2. Click ‘Add’.
3. Enter Branch information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).

- Agency ID (Parent of this Branch)
- Branch ID Format
  - Characters 1 – 2 = numeric State Code of the Agency with which this Branch is associated.
ii. Character 3 = ‘Q’
iii. Characters 4 - 7 = last four (4) numbers in the Agency’s CCN.
iv. Characters 8 - 10 = a sequential number 001 – 999.
c. Branch State

4. After branch information has been entered:
   a. Click the Save icon in the Tool Bar
      OR
   b. Click the Save Branch option in the File drop down options
      OR
   c. Click the ‘Add Branch’ button at the bottom of the screen.

5. Saved Branch information will display in the Branch Summary section.

6. To add additional Branches
   a. Click the New icon or the Add Branch button.
   b. Enter data and click the Save icon.
      OR
   c. Click the ‘Add Branch’ button at the bottom of the screen.

**Branch Screen - Search**

For detail of how to perform this search, go to [jHAVEN User Tool Search](#).

**Branch Screen - Modify a Branch**

Complete the following steps to modify an existing Branch.

1. If a specific branch, or set of branches is required, Search. See [jHAVEN User Tool Search](#).
2. Locate and highlight the Branch in the summary section.
3. Make the appropriate changes on the right side of the screen.
4. Click the Save icon.
5. The branch data will be saved.

**Branch Screen – Special Functionality**

**Effects of Modifying the Branch ID and/or Branch State**

The User may modify the Branch ID and or the Branch State in an existing Branch. When this is done through the Branch screen, the following activities occur within all the Administration Screens and Assessments.

- Any Agency that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.
- Any User that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.
- Any NON-exported assessment associated with the original Branch will be automatically updated with the NEW Branch data at the time this data was saved.

**Branch Screen - Delete a Branch**

Complete the following steps to delete a Branch.

1. Locate and highlight the Branch in the summary section.
2. Click the Delete icon
   OR
3. Click the ‘Delete Branch’ button at the bottom of the screen.

**RULES:**
1. Only System Administrators may delete Branch records.
2. A Branch cannot be deleted if it has been associated with a User.
3. A Branch cannot be deleted if one or more assessments have been created using that branch.

**Sample Messages:**

The following sample is generated when the association is with an active User.

![Image of Cannot delete a Branch with one or more Users]

The following sample is generated when the association is with an Assessment.
Patient Screen – Add & Maintain a Patient

The Patient screen allows users to add, edit, delete and search for Patients.
To access the Patient Screen select the Patient option from the Administration drop down on the menu bar.

The System Administrators and Data Entry Users may add and manipulation Patient records.

Patient Screen – Create a Patient

Patients may be added to the jHAVEN application by the System Administrators and Data Entry Users.
Complete the following steps to add a new Patient:

1. Display the Patient Screen.
Note: The following in the Patient Detail panel of the Patient screen broken down into three (3) sections.
2. Click ‘Add’.
3. Enter Patient information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
   a. Agency ID (Agency of this Patient)
   b. Patient Last Name
   c. Patient State of Residence
   d. Patient Zip Code
   e. Medicare Number
   f. Social Security Number
   g. Medicaid Number
   h. Birth Date
   i. NPI Number
   j. Race/Ethnicity
   k. Payment Source
4. After Patient information has been entered:
   a. Click the Save icon in the Tool Bar
      OR
   b. Click the Save Patient option in the File drop down options
      OR
   c. Click the ‘Add Patient’ button at the bottom of the screen.
5. Saved Patient information will display in the Patient Summary section.
6. To add additional Patients,
   a. Click the New icon or the Add Patient button.
   b. Enter data and click the Save icon.
      OR
   c. Click the ‘Add Patient’ button at the bottom of the screen.

**Patient Screen - Search**

See [jHAVEN User Tool Search](#) for all searches required based on patient data found on the Patient Screen.

**Locate Assessments from the Patient Screen**

If a System Administrator or a Data Entry User needs to see all the Assessments associated with a specific Patient, they may do so using the ‘View Assessments’ feature. Complete the following steps to see a list of all the assessments for a specific patient.

1. Open the Patient Screen.

2. Do a Patient Search to locate the patient whose assessments are to be viewed.

   NOTE: There are two sample screen shots that follow. The first (2a) illustrates using the ‘View Assessments’ button without selecting any search Criteria on the Patient Search. The second (2b) illustrates using the
‘View Assessments’ button with Search Criteria being used on the Patient Search.

a. The Patient Search button was used to get all the patients associated with this user. They are viewed here in the Patient Summary. No Search Criteria has been used, so all Search Criteria fields are blank.

NOTE: 1) Patients are associated with a Data Entry User via the Agency ID. These uses see only Patient from their own specific Agency. 2) System Administrators are associated with Patients associated with all Agencies; therefore with all Users.

The user entered search criteria on the Patient screen before using the Search button. Only those patients associated with this user AND fitting the search criteria were returned in the result; viewed here in the Patient Summary. The user will be able to highlight only one of the two patients listed in this summary.
3. Highlight the specific patient’s row from the Patient Search Summary.
4. Click the ‘View Assessments’ button.
5. The Assessment Search will be initialized. When all the assessments are located for the one patient selected, they will be displayed in the Assessment Search Summary.

   a. Using either cases illustrated in 2a and 2b above, NO search criteria is shown in the Assessment Search Criteria fields. If a search criterion is used in the Patient Search on the Patient Screen, it does not carry over into the Assessment Search screen.

   Note: The Patient Search Criteria is NOT used in the Assessment Search for Assessments.

   b. The Assessment Criteria fields. If the Assessment Search Screen was already an inactive open screen AND previously had Assessment Search Criteria entered, that previously entered data would still be seen in the Assessment criteria fields. Although, it does NOT reflect the data in the Summary from the Patient’s assessments search.
6. The user may continue with their activities using the Assessment Search Summary data.

**Patient Screen - Modify a Patient**

Complete the following steps to modify an existing Patient.

1. If a specific Patient, or set of Patients, is required, complete the search process
2. Locate and highlight the Patient in the summary section.
3. Make the appropriate changes on the right side of the screen.
4. Click the Save icon.
5. The Patient data will be saved.

**Patient Screen – Special Functionality**

**Effects of Modifying Patient Data**

The User may modify the Patient data in an existing Administration Patient screen if there are assessments associated with any patient whose data has been updated, when these assessments are re-opened, a Decision Message will be displayed.

The User must determine whether to allow the assessment to be updated with the new patient data, or not.
Move a Patient from One Agency to Another Agency

A patient is assigned to an agency via the Administration Patient Screen. Each patient must be associated with an Agency at the time the patient is added into jHAVEN.

RULES:
1. To move a Patient from one Agency to another, all the existing assessments, created under the existing Agency, must be exported.

First review this patient’s assessments and export any assessments that have NOT been exported. See Exporting Assessments for Submission into ASAP.

If there are non-exported assessments for the patient and the user wishes to move that patient, the following message will display.

Complete the following steps to move a patient from one agency to another agency.
1. Open the Patient screen and locate the patient to be moved.
2. Highlight the Patient to be moved.
3. Modify the Agency ID.
4. Click the Save icon to save the Patient.
5. The Confirm Change Agency Screen is displayed.

6. “Are you sure you want to change the agency for the <Patient First Name> <Patient Last Name>?
The following assessments for this patient will remain in the original agency where they were created:”
   a. The “Assessment Information” grid will include:
      i. Reason for assessment
      ii. Correction Number
      iii. Status of the assessment
      iv. Effective Date.

7. Click Finish to continue.
8. The Information Message will be displayed.

9. Review the Patient Summary.
   a. Look for the patient that was moved. Because this patient had exported assessments, there will be:
      i. One row associated with the original Agency ID with the exported assessments and
      ii. A second row associated with the new Agency ID and no assessments.
NOTE: If the Patient to be moved has NO ASSESSMENTS, then there will only be one (1) row in the Patient Summary. There were no exported assessments to be associated with the Patient’s original Agency ID.

**Patient Screen - Delete a Patient**

Complete the following steps to delete a patient.

1. Locate and highlight the patient in the summary section.

   ![Patient Information Screen](image)

2. Click the Delete icon.

   OR

3. Click the Delete Patient button at the bottom of the page.
4. Click the 'Delete Patient' button.
5. The Patient will be deleted and the Patient Screen will be closed.

**RULES:**

1. A patient cannot be deleted if one or more assessments have been created for the patient.

If the Patient has an assessment, and the user tries to delete that patient, complete the following steps:

1. The “Cannot Delete a Patient with one or more Assessments” pop-up Window displays.
2. Click ‘Cancel’ button.
   a. The pop-up window will be closed.
   b. The delete will not be processed.
   c. User will be returned to the Patient screen.
Assessments

Create an Assessment

To create an assessment the following must already be accomplished or available:

• Successful Login
• Existing Administration Data: Agency, User, and Patient

Select a Patient

Complete the following set to create an assessment:

1. Select the Patient option from the Administration drop down on the toolbar.

2. The Patient Screen displays.
3. User may need to add the patient as a new patient.

OR

4. User needs to search for the desired patient.
5. The Patient summary will display the patient(s).
6. One patient should be is located and highlighted.

7. Double-click on the highlighted patient.
8. This will Launch the Assessment Wizard.
Launch the Assessment Wizard

The Wizard is a pop-up window used for creating all assessments.

1. In the Patient Summary section, double click on a highlighted patient
   OR
2. Click the Add Assessment button at the bottom of the patient screen.
3. The “Add Assessment for Patient <<Patient First Name>> <<Patient Last Name>>” Pop-up window is displays.
4. Select the OASIS Specification time period based on the anticipated Completion Date (M0090).
   a. 10/01/2015 – Ongoing
   b. 01/01/2015 - 09/30/2015
   c. 0101/2010 – 21/31/2014

   NOTE: If the incorrect time period is selected, the assessment will need to be deleted and re-keyed.

5. Select the type of assessment.

6. The Finish button is enabled. Click Finish to continue to the Assessment screen.

   NOTE: After clicking Finish, errors and/or warning messages, if applicable, will display in a pop up screen.

7. The Assessment Screen displays.

The Assessment Screen

The assessment screen automatically displays.

Tabs for any open Administration Screen will display below the toolbar at the top of the screen under the Assessment. When the Assessment screen is active, no other screen may be accessed. When a user tries to view one of the Administration screens:
1. An error message displays.
2. Click OK to close the error.
3. User is returned to the Assessment screen.

**Assessment Details – Screen Sections**

The specific Assessment tab displays the assessment type and patient name.
**Navigator**
The Navigator is on the left side of the assessment screen.

The navigator is a collapsible “tree”, which list all the assessment categories and the assessment questions. The fields for the questions that require answers are in bold. As questions are answered, they are removed from the tree. The Show/Hide Answered Questions icon in the toolbar at the top of the screen will also change the display of the tree.

Clicking on an item in the tree will directly place the cursor in the selected field.
Edits List

The Edit section is located on the bottom left corner of the assessment screen.

The errors and warnings are found in the display area.

Clicking on an edit message will move the cursor within the assessment to the appropriate field.

There are some errors, which present a pop up message, during the data entry process, and these must be addressed at the time they are displayed, in order to proceed. These edits will not display in the Edits listing.

Assessment Data Tabs

There are four (4) tabs directly associated with the Assessment located on the top right side of the assessment screen.

- Assessment
- Patient Details
- Agency Details
- Assessment Determination
**Assessment Tab**

This section will be the section used for the actual assessment questions and answers. This is where data entry is accomplished.

---

**Start of care—further visits planned**

**PATIENT TRACKING SHEET (Alt+1)**

| M0010. CMS Certification Number: | 979896 |
| M0014. Branch State: | IA Iowa |
| M0016. Branch ID Number: | 16Q9896001 - IA |
| M0018. National Provider Identifier (NPI) for the attending physician who has signed the plan of care: |  |
| M0018. UK. NPI Unknown or Not Available: |  |
| UK - Unknown or Not Available - checked |  |
| M0020. Patient ID Number: | P02 |
| M0030. Start of Care Date: |  |
| M0032. Resumption of Care Date: |  |
| M0032 NA. No Resumption of Care Date: |  |
| NA - Not Applicable |  |
| M0040. F. First Name: | PFName02 |
| M0040 M. Middle Initial: | M |
| M0040 L. Last Name: | PLName02 |
| M0040 S. Suffix: | Sr |
| M0050. Patient State of Residence: | IA Iowa |
| M0060. Patient Zip Code: | 50266 |
| M0063. Medicare Number: | 981276345434 |
**Patient Details Tab**

Patient data is displayed in a view only, non-editable, format.

![Image of Patient Details Tab]

**Agency Details Tab**

Agency data is displayed in a view only, non-editable, format.

![Image of Agency Details Tab]

**Assessment Determination**

![Image of Assessment Determination]

**Data Entry into the Assessment**

When the assessment is first open after the ‘Add Assessment Wizard’ is completed, there are various data fields, which pull their data from the Administration Screens. These are pre-populated and may not be changed within the assessment, with ONE exception. The exception is the Payment Source.

The Payment Source (M0150) data will be populated from the Patient Screen when the assessment is created. Further changes to this field, on the Patient Screen, will NOT be populated, and therefore not reflected, in the assessment at any later time.

The Payment Source (M0150) may be changed within the assessment itself. This allows the user to set the payment source for a patient specifically for each assessment regardless of how it is set on the Patient screen.
TIPS: For optimization of the skip patterns and/or edits, it is recommended that assessment data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

Enter data in each field and use the “Tab” key on the keyboard to navigate from field to field. This allows skip patterns and edits to be appropriately applied and helps ensure all fields are addressed.

The User will not be able to enter different or additional data in these fields, with the EXCEPTION of the Branch ID data field (M0016).

The Branch ID field maybe changed using the dropdown options provided. The Branch State is automatically pulled from the Administration Branch Screen for the specific Branch ID selected.

Complete the following steps to complete data entry into the assessment. Data Entry may be complete all in one sitting, or spread out across several.

1. Enter applicable data into the assessment beginning at the top of the Assessment tab.
2. Pop-up edit messages must be addressed as they are displayed before continuing on with the data entry field. These edits will not display in the Edits listing in the lower left portion of the screen.
3. Edit Messages, Errors and Warnings

   a. Errors and warnings found on the data, display in the lower left of the screen in the ‘Edit’ section of the assessment.
RULES:
1. Error edits must be corrected before the assessment can be Exported.
2. Warning edits provide only a warning. It is up to the user to enter the data appropriately. Warning Edits would not stop the assessment to be exported.

   NOTE: For the system to calculate HIPPS values for the assessment, there are specific data fields must be completed; questions answered. When they are not answered.

4. There are two options for saving this data.
a. Click the Save icon.
b. Click the Save and Validate icon.

Save

TIP: Before closing an assessment – SAVING - always tab forward off the last field entered. This will ensure that that last field is saved.

When a ‘Save’ is selected for an assessment, the data is simply saved. It is NOT validated. The status of the Assessment will be set to “IN_USE”. Once the data has been saved, the user may then close the assessment.

This assessment may be re-opened at a later time for more data entry or for the ‘Save & Validate’ process.

Save & Validate
The following process occurs when ‘Save & Validate’ icon is selected.
1. The appropriate Data Specification, selected when assessment was created, is loaded.

2. The data is verified and validated using the jHAVEN VUT.
3. If there are no errors, the assessment will become ‘EXPORT_READY’.
4. If errors and/or warnings are found, they will be identified and provided in the ‘Edits’ list.

5. Even when errors are found, the Assessment is saved.

6. User may continue editing and adding data to the assessment and ‘Save & Validate’ again.

   OR

7. The User may choose to simply close the assessment “as is”.

**Print the Error Report**

To print the Assessment Error Report:

1. Click the Print Error Report button below the Edits section

   OR

2. Click the Print Assessment Error Report icon on the toolbar.

   OR


4. The Report Viewer displays the report.
## Assessment Error Report

**Assessment Type:** 1 - Start of care - further visits planned  
**Assessment Date:** 02/25/2014  
**Last Name:** PName02  
**Effective Date:**

<table>
<thead>
<tr>
<th>Question</th>
<th>Severity</th>
<th>Error Number</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>M0G30_START</td>
<td>Edit</td>
<td>-3070</td>
<td>Invalid value for this item - it is not a valid YYYYMMDD date value and it is not a valid alternative value as specified in the Data Specifications. [null]</td>
</tr>
<tr>
<td>M0G32_ROC_D Edit</td>
<td>Error</td>
<td>-3490</td>
<td>If M0G32_RCC_DT NA=[0], then if M0032_ROC_DT is active it must not equal ['']</td>
</tr>
<tr>
<td>M0G32_ROC_D Edit</td>
<td>Error</td>
<td>-4170</td>
<td>If M0G30_ASSMT_REASON='01', then M0032_ROC_DT NA must be ['']</td>
</tr>
<tr>
<td>M0060_ASSESS Edit</td>
<td>Error</td>
<td>-5000</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M0102_PHYSN Edit</td>
<td>Error</td>
<td>-3560</td>
<td>If M0412_PHYSN_ORDRE革_SOCROC_DT='[']&quot;, then if M0102_PHYSN_ORDRE革_SOCROC_DT NA is active it must equal ['']</td>
</tr>
<tr>
<td>M0104_PHYSN Edit</td>
<td>Error</td>
<td>-3600</td>
<td>If M0102_PHYSN_ORDRE革_SOCROC_DT='[']&quot;, then if M0104_PHYSN_RFRL_DT is active it must not equal ['']</td>
</tr>
<tr>
<td>M0110_EPISODE Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_JPP Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_JRF Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_LT Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_LT Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_NO Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_OT Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_PS Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_SN Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1018_CHGRE Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1018_PRIOR_Edit</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
</tbody>
</table>

[ ] - Not Assessed, [ ] - Skipped

1 of 6

1 - Start of care - further visits planned - PName02 PName02 null
Opening an Existing Assessments

There are different procedures to follow when opening different assessments with various ‘Statuses’. Once the desired Assessment is listed in the Assessment Search Summary, highlight it and double click to open it. Based on the Status of this assessment, follow the steps indicated in the following sections.

Opening an Existing NON-EXPORTED Assessment

All User Roles may open any assessment that appears in the Assessment Search Summary, with which that user is associated. However, the View Only User may only view the assessment. They have no access to update the assessment in any way.

NOTE: System Administrators may open any and all Assessments.

Assessments in the following statuses may be opened and edited as many times as necessary before being exported.

- NEW
- IN_USE
- DATA_ENTRY
- EXPORT_READY
- COMPLETE

Complete the following steps to edit an existing assessment.
1. Search for the desired assessment (Use the jHAVEN User Tool Search section).
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Assessment screen opens for editing.
4. Edit the assessment if applicable.
5. If changes are made, click the Save and Validate icon on the toolbar.
6. Close the assessment.

Administration Screen Data Has Changed

When the Administration Data is modified AND it is associated with an assessment, it will not be reflected in that assessment at the time the data was actually modified using an Administration Screen. Only when the assessment is opened by a user with access to update an assessment, in the edit mode, will the user be asked if their wish to have that assessment updated with the new data.

If the user says, “yes”, then the application will pull the administration data into the assessment.

NOTE: The User will continue to get this Decision Message until the user answers it with the “Yes” option.
Agency
The Agency data fields, affecting the Assessment, are reflected on the Agency Details tab on the Assessment screen.

Branch
Branch data fields are reflected within the Assessment as soon as they are modified on the Administration Branch Screen. Therefore, there will be no Decision Message for Branch data.

Patient
The Patient data fields, affecting the Assessment, are reflected on the Patient Details tab on the Assessment screen.

User
The User, if terminated, using the Termination Date on the Administration User Screen, will display a message.
Opening An EXPORTED Assessment

Only a user with a System Administrator role may edit an assessment that has been exported.

Complete the following steps to edit an existing assessment with a status of EXPORTED.

1. Search for the desired assessment.
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Exported Assessment message box displays.

4. User has four (4) options and must select one of them or Cancel the open.
   a. ‘Open this assessment in read only mode’
      i. Assessment opens and displays all previously selected answers from the assessment in a view only, non-editable format.
   b. ‘Create a correction record’
      i. The Correction Number is incremented by ‘1’.
      ii. Assessment opens and displays all previously selected answers from this assessment.
   c. ‘Create an inactivation record’
      i. The Inactivation Assessment opens. All fields are a view only, non-editable format. Once saved, the Reason For Assessment (RFA) Type will be changed to XX-Inactivation.
   d. ‘Reset Status and Edit’
      i. The Assessment opens and displays all previously selected answers in an editable format.
      ii. The Correction Number is NOT incremented.

TIP: Use the Help button to review the options as they were originally in Classic HAVEN.

5. Once an option is selected, click ‘OK’.
6. The assessment will open.
7. Edit the assessment if required.
8. If changes are made, click the Save and Validate icon on the toolbar.
9. Close the assessment.
**Opening an Inactivated Assessment**

Complete the following steps to copy an inactivated assessment with a status of EXPORTED. These will start with an Assessment Type of XX- Inactivation. Only one copy per inactivated assessment is allowable.

1. Search for the desired assessment (Use this jHAVEN User Tool Search section).
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Exported Assessment message box displays.

4. User has 3 options
   a. ‘Open this assessment in read only mode’
      i. Inactivation Assessment opens and displays fields in a view only, non-editable format. This selection checks the View Only checkbox at the bottom of the Assessment Search screen. All other assessments will be view only until this box is unchecked.
   b. ‘Create a copy record’
      i. A new Assessment opens and displays all previously selected answers from the most current inactivated record. If a copy has already been made from this inactivation assessment, this option will NOT be available.
   c. ‘Reset Status’
      i. The status of the assessment is also reset to EXPORT_READY, if assessment was Saved and Validated and is without errors.
      OR
      ii. The status of the assessment is also reset to IN_USE, if assessment was closed without saving.

   TIP: Use the Help button to review the options as they were originally in Classic HAVEN.

5. Once an option is selected, click ‘OK’.
6. The assessment will open.
7. Edit the assessment if required.
8. If changes are made, click the Save and Validate icon on the toolbar.
9. Close the assessment.
Editing/Modifying an Assessment

1. Locate desired assessment using the jHAVEN User Tool Search.
2. Add/Modify assessment data using same methods used when adding a new Assessment.
3. Click the Save and Validate icon on the toolbar.
4. Close the assessment.
   a. Click the ‘X’ on the assessment tab.
   OR
   b. Click the option under the File Menu of Close assessment.

Viewing an Assessment in View Only Mode

Complete the following steps to open an assessment in view only mode.
1. Search for the desired assessment using the jHAVEN User Tool Search.
2. Check the View Only checkbox at the bottom of the screen.
3. Double click on the desired assessment or select the desired assessment and click the View Assessment button at the bottom of the screen.
4. The Assessment screen opens in view only mode.
5. An assessment in view only mode cannot be modified. If this assessment is closed and the user tries to open another assessment from the Search screen, it will be displayed as view only also. The user will need to uncheck the View Only checkbox before opening the assessment to make changes to it.

Close the Assessment

TIP: Before closing an assessment – SAVING - always tab forward off the last field entered. This will ensure that that last field is saved.

Close the assessment by:

1. Click the ‘X’ on the corner of the Assessment Tab.
   OR
2. Click the ‘Close Assessment’ option under the File Menu.
3. The Assessment closes.
Delete An Assessment

RULES:
1. Only a user with a System Administrator role may delete an assessment.
2. Assessments with a status of EXPORTED cannot be deleted.

Complete the following steps to delete an assessment.
1. Search for the desired assessment using the jHAVEN User Tool Search.
2. Click once on the desired assessment.
3. Click the Delete Assessment button at the bottom of the Assessment Search screen to delete the selected assessment.
4. The ‘Confirm Assessment Delete’ message displays.

![Confirm Assessment Delete](image)

5. Click OK to delete the assessment.

NOTE: Click Cancel to close the message and not delete the assessment
Exporting Assessments for Submission into ASAP

EXPORT RECOMMENDATION: The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using export feature. It is strongly recommended to export assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Export Assessments screen allows the user to determine what data is to be exported. There are two (2) options for the types of exports. The screens for the two options are different.

- New Exports
- Previous Exports

To initiate the Export screen, select the Export option from the Import/Export drop down on the toolbar.

New Exports

Complete the following steps the export an Assessment, after the Export Type of ‘New Export” has been selected from the drop down.

1. Select the Export Path. This field is required. This is the location where the exported files will be stored.
   a. Click on the Browse button to navigate to the location where the files will be exported.
   b. Locate the folder and click ‘OK’.

   NOTE: Once the Export Path is establish in jHAVEN, that path will become the DEFAULT until it is changed again.

2. Enter an ‘Export Name’ for this exporting process.
3. Enter an ‘Export Description’ for this exporting process.
4. Review the ‘Assessments to be Included in the Export’. Check the check box in front of all these assessment to be included.
   a. User may use the ‘Select All’ icon, which will place check marks in all the check boxes for all the assessment listed.
   b. User may use the ‘Clear All’ icon, which will remove check marks from all the check boxes for all the assessment listed.
5. The user may run the ‘Error Check’ on the assessment(s).
   a. Check the checkbox in front of the assessment(s). Click the ‘Error Check’ icon.
   b. The Status Report displays.
   c. Select the ‘Save to File’ button to save the error report (.txt).
6. Click the ‘Export’ icon to begin the exporting process.

   NOTE: Any assessments that do not have checks in the check boxes in front of the Patient Name will NOT be included in the export.
7. The files are ready for submission to the national database.
1. After selecting the ‘Export Type’ of Previous Export. Locate the ‘Export Path’. Click on the Browse button to navigate to the location where the files will be exported.

2. Enter the Export Name.

3. Select the Export Description. This field can be used to document details regarding the export.

4. A list of previously exported assessments available to be exported is displayed.

5. Select/highlight a ‘Previous Export’.

6. A list of assessments available to be exported is displayed. A minimum of one selection is required.

7. A Loading Data Specs message displays. This process loads the submission data specifications to be used by jHAVEN for data validation of assessments during import. The assessments are compared to the submission edits.

8. The Export complete message displays to notify the user the process is complete.
   a. The location of the exported files displays in parenthesis at the end of the message.

9. The files are ready for submission to the national database.
**Action Buttons on the Export Screen**

The action Buttons at the bottom of these screens will provide the following functions.

**Left Side**

At the bottom of the export screen, on the left-hand side of the screen, are two (2) buttons.

1. The Select All button will select all assessments displayed in the list to be included in the export file.
2. The Clear Selection button will unselect all assessments previously selected.

**Right Side**

At the bottom of the export screen, on the right-hand side of the screen, are three (3) buttons.

1. If desired, select the Print Assessment List button to print a list of assessments included in the file to be exported.

   NOTE: When this report is generated, it does not display on the screen. The user must print it.

2. Select the Error Check button to validate and/or check for errors on all previously selected assessments. Error results display in a new screen.
3. Select the Export button to export selected assessments for submission.

**Import Data from Outside Source**

IMPORT RECOMMENDATION: The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using import feature. It is strongly recommended to import assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Import Assessments screen allows the user to determine how data is imported. Complete the following steps to import an assessment.

1. Select the Import option from the Import/Export drop down on the toolbar.

2. The Import Assessment screen displays.
3. Select the Location.
   a. Click on the Browse button to navigate to the location of the files to be imported.
   b. Select the location from which to pull the import file.

4. If no warning message is wanted when a patient is added into jHAVEN during the import process, check the ‘Patient Data Options’ checkbox to turn off the warning message.

5. Select the options from the Miscellaneous Data Options list by checking the checkboxes in front of the options.
6. Click the ‘Select All Options’ button to check or uncheck all checkboxes.
   a. OPTIONS:
      i. “Do not display warnings in error check results.” This selection removes warning messages from the error check results report that displays after importing data. Only fatal errors are included in the report.
      ii. “Assign Exported status to assessments without errors (instead of Export Ready.)” This selection sets the status of imported assessments to Exported, if the record does not have errors.
      iii. “Associate assessments with a blank Agency ID field to the selected agency below.” This selection provides to allow the system to import assessments, which have no Agency ID, by using the agency select from the dropdown below.
      iv. “Associate assessment with a blank M0090 date to the selected data specification version.” This selection provides the means to allow the system to import assessments, which have a blank Completion Date field, by using a valid data specification based on the date range selected from the drop down below.

7. Select the ‘Error Check’ button to validate and/or check for errors on all assessments to be imported. Error results display in a new screen.
8. Click the Import button to import selected assessments into jHAVEN.
9. The import process begins.
10. A ‘New Patient’ message displays if the warning option is not checked.

11. Click the ‘Yes’ button to continue with the import of the assessment.

   NOTE: Clicking the ‘No’ button will cancel the importing of only this assessment. Clicking the ‘Cancel’ button will stop the import process.
12. A Loading Data Specs message displays. This process loads the submission data specifications to be used by jHAVEN for data validation of assessments during import. The assessments are compared to the submission edits.

13. An ‘Import complete’ message displays as well as a Status Report for all assessments included in the import.

14. If no files are successfully imported, the Import failed message box displays along with a Status Report.

15. Click the ‘OK’ button on the Import Complete pop-up window to view the Status Report.

16. Click on the Save to File button, on the bottom of the report, to save a copy of the report to the computer.

17. Click on the ‘X’ icon in the top right corner to close the report.
jHAVEN Application Reports

jHAVEN reports allow users to preview and print assessment information, as well as detail and summary information for both agencies and patients.

Report Viewer

The jHAVEN application reports are generated in third-party software, Report Viewer, using this software’s ICONS and formatting. All the reports use this software in the same fashion.

Print Report

To print the report, click the Print icon on the Report Viewer screen.

Save Report

To save the report, click the Save icon on the Report Viewer screen.

Export Report

To export a report, click the arrow next to the Save icon. The available export values display.

To select an export type, use the dropdown arrow by the Save icon to select a location to export (save) the report and click Save.
Available jHAVEN Reports

Available jHAVEN Reports are:

- Event Tracking
  - Assessment Data
  - Agency
  - Branch
  - Patient
  - User
- Assessment Data Entry By Status
- Assessment Data Entry By Branch
- Data Comparison

Event tracking Reports

Complete the following steps to run the Event Tracking report.

NOTE: Only the System Administrator User ID can run the Event Tracking reports.

1. Select Event Tracking from the Reports drop down on the toolbar.

   a. Accessibility Off
b. Accessibility On

3. Select Event.
   a. “Event drop down. Use up and down arrows to select an Event.”
4. Select or enter the ‘Event Dates’.
   a. “From, Date”
   b. “To Date”
5. Select the ‘OK’ button to generate the report.

   NOTE: Selecting the Cancel button will close the parameter screen; no report will be generated.


Agency Event Tracking Report
### JHAVEN - Home Assessment Validation and Entry System

**Agency Event Tracking**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Agency Name</th>
<th>Agency City</th>
<th>State</th>
<th>Assigned ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Jhaven</td>
<td>Tue. 11 Feb 2014</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue. 11 Feb 2014</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue. 11 Feb 2014</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue. 11 Feb 2014</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed. 26 Feb 2014</td>
<td>Home Health Agency 02</td>
<td>Akron</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed. 26 Feb 2014</td>
<td>Home Health Agency 02</td>
<td>Akron</td>
<td>IA</td>
<td>HH01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed. 5 Mar 2014</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HH01</td>
</tr>
</tbody>
</table>
**User Event Tracking Report**

jHAVEN - Home Assessment Validation and Entry System

User Event Tracking
03-06-2014 thru 03-05-2014
Requested by: SysAdmin01
Event User

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Login ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:43:06</td>
<td>VOnly01</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:44:09</td>
<td>VOnly02</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:45:20</td>
<td>VOnly03</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:46:25</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:47:08</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:48:07</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 12:40:50</td>
<td>SysAdmin01</td>
</tr>
</tbody>
</table>
### Branch Event Tracking Report

#### jHAVEN - Home Assessment Validation and Entry System

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Branch ID</th>
<th>Branch Name</th>
<th>Branch City</th>
<th>Branch State</th>
<th>Agency ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>11 Feb 2014 13:25:31</td>
<td>16Q6890001</td>
<td>HHA01_00031</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>11 Feb 2014 13:26:00</td>
<td>16Q6890001</td>
<td>HHA01_00031</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>11 Feb 2014 13:26:25</td>
<td>16Q6890001</td>
<td>HHA01_00031</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>11 Feb 2014 13:26:49</td>
<td>16Q6890001</td>
<td>HHA01_00031</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>11 Feb 2014 13:27:16</td>
<td>16Q6890001</td>
<td>HHA01_00031</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>5 Mar 2014 16:17:02</td>
<td>16Q6890002</td>
<td>IA</td>
<td>Home Health Agency 01 - HHAC01(A)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>5 Mar 2014 10:19:01</td>
<td>16Q1287001</td>
<td>IA</td>
<td>Home Health Agency 02 - HHAC02(A)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Patient Event Tracking Report

Assessment Event Tracking Report
Assessment Data Entry – By Status Report

Complete the following steps to run the Assessment Data Entry – By Status report.

NOTE: All User Roles can run this report.

1. Select Assessment Data Entry – By Status from the Reports drop down on the menu bar.

2. The Criteria parameter screen for ‘Assessment Data Entry – By Status’ report displays.

3. Select an Agency.
   a. “Agency drop down. Use up and down arrows to select an Agency.***”

4. Select Status.
   a. “Status list. Use up and down arrows to select a status.***”
      b. To select all statuses, hold the SHIFT button while you select or scroll through the list.
      To select a few statuses, hold the CTRL button while you select what you need.

5. Select the ‘OK’ button to generate the report.

   NOTE: Clicking the ‘Cancel’ button to close the parameter screen.

Assessment Data Entry – By Branch Report

Complete the following steps to run the Event Tracking report.

NOTE: Only the System Administrator User ID can run this branch report.

Complete the required fields which are marked with an asterisk (*).

1. Select the ‘Assessment Data Entry – By Branch’ report from the Reports drop down on the toolbar.

2. The Criteria parameter window displays.
   a. Accessibility Off.
b. Accessibility On.

3. Select Agency.
   c. “Agency drop down. Use up and down arrows to select an Agency*

4. Select Branch.
   d. “Branch drop down. Use up and down arrows to select a Branch*

5. Select Status.
   e. “Status list. Use up and down arrows to select a status*
       f. To select all statuses, hold the SHIFT button while you select or scroll through the list.
       g. To select a few statuses, hold the CTRL button while you select what you need.

6. Select/enter a date range.
   h. “Data Entry Date”
       i. “From**”
       j. “To**”

7. Select the ‘OK button to generate the report.

   NOTE: Clicking the Cancel button to close the parameter screen.

8. The Report Viewer screen opens displaying the generated report.
Data Comparison Report

Complete the following steps to run the Data Comparison report.

NOTE: Only the System Administrator and the Data Entry User can run this report.

Complete the required fields which are marked with an asterisk (*).

1. Select the ‘Data Comparison Report’ report from the Reports drop down on the toolbar.

2. The Criteria parameter window displays.
   a. Accessibility Off.
   i. Required fields are: Agency and Date Range.
3. Select Agency.
   
   c. “Agency drop down. Use up and down arrows to select an Agency*”
   
   d. Rules:
      
      i. System Administrators may select the Agency from multiple options listed in the drop down.
      
      ii. Data Entry Users will have only one option; the agency with which they are associated.
   
4. Select/enter a required date range.
   
   e. “Data Entry Date”
   
   f. “From***”
   
   g. “To***”

5. Select the ‘OK’ button to generate the report.

   NOTE: Clicking the Cancel button to close the parameter screen.
The Report Viewer screen opens displaying the generated report.

<table>
<thead>
<tr>
<th>Patient Name</th>
<th>SSN</th>
<th>Reason For Assessment</th>
<th>Status</th>
<th>Effected Fields</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus, Chevy</td>
<td></td>
<td>4 - Recertification</td>
<td>IN_USE</td>
<td>PATIENT:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ethnicity: '6 - White' changed to '2 - Asian, 6 - White'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>First Name: 'Ford' changed to 'Cherry'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Middle Initial: 'J' changed to blank</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>State: 'AL Alabama' changed to 'DE Delaware'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>AGENCY:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Agency ID: 'A1D' changed to 'SAID123'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Agency Name: 'Agency Name' changed to 'Agency B'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>National Provider ID: '24807349397' changed to blank</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>1 - Start of care</td>
<td>IN_USE</td>
<td>PATIENT:</td>
<td>07/02/2014</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ethnicity: '6 - White' changed to '2 - Asian, 6 - White'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>First Name: 'Ford' changed to 'Cherry'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Middle Initial: 'J' changed to blank</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>State: 'AL Alabama' changed to 'DE Delaware'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>AGENCY:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Agency ID: 'A1D' changed to 'SAID123'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Agency Name: 'Agency Name' changed to 'Agency B'</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>National Provider ID: '24807349397' changed to blank</td>
<td></td>
</tr>
</tbody>
</table>
Closing the Application

Session Time Out

To assist with keeping data secure in jHAVEN, if at any time during data entry there is no activity by the user for 15 minutes, the system will timeout and a warning will be issued.

To continue with the session, the user may click OK. If the user does not click OK before the time displayed on the pop-up, the user will be logged out of jHAVEN and the login screen will be displayed.

IMPORTANT NOTE: Any data entered will not be saved.

Save Resources Pop-up Window

If data has been updated, and those screens have not been saved, then the user will see a pop-up window listing those updated screens.

Complete the following steps to save the screens with updates still not saved.
1. Select the resources to save. Each resource listed will have a check box in front of it.
   a. To save an item, make sure the check box is checked.
   b. To close an item without saving it, uncheck the check box.
   c. To save all the items listed, click the ‘Select All’ button.
   d. To NOT save any of the items, click the ‘Deselect All’ button,

Note: The default for these check boxes is that they ARE CHECKED.
Logout

To log out and return to the login screen, select the Logout option from the Security drop down on the menu bar. Unsaved updated Screens will return the Save Resources Pop-up Window.

This allows the user to log into the application again.

Exit

To close jHAVEN, select the Exit option from File drop down on the menu bar. Unsaved updated Screens will return the Save Resources Pop-up Window.
jHAVEN can also be closed by selecting the close icon in the top right corner of the screen.

Data Backup on Close

jHAVEN creates a backup of the database when the application is closed following an active session. Complete the following steps to close and backup data.

1. Select the Exit option from the File drop down on the menu bar.

2. The Backup jHAVEN Database message displays.

3. Choose one of the following options.
   a. Click Yes to back up the database and close jHAVEN.
   b. Click No to not backup the database and close jHAVEN.

   NOTE: However, if a backup has not occurred within the last 7 days of an active session, the jHAVEN system will not display the above question (steps 2 & 3). Instead, the system will automatically backup the database when closing the current session.

If Yes is selected, the pop-up that indicates the backup is in process will be displayed. When the backup is complete this window closes automatically.

The status of the completed backup will be displayed in another pop-up window providing the status of the completed backup.
NOTE: To restore the database from a prior backup copy, see Miscellaneous System Maintenance, Database Backup and Restore.

Security

All User Roles have access to the Security Menu Bar selection. The available options are:

- Change Security Answers
- Change Password
- Logout

Change Security Answers

Complete the following steps to change your answers to your security questions:

1. Login to jHAVEN. See Opening the jHAVEN Application.
2. Click on the Change Security Answers option. A pop-up window will be displayed, which requires the confirmation of the users’ current password.
3. Enter the password
4. Click ‘OK’ button.

Note: Clicking the ‘Cancel’ button will end this process.
5. The ‘Security Questions’ pop-up window displays.
6. Enter at least six (6) answers AND tab forward.
7. Click ‘OK’ button.
8. The window is closed and the new answer is saved.

**Change Password**

User passwords may be changed at any time. However, all Users will be asked to change their passwords every 60 days. Complete the following steps to change a password.

1. Login to jHAVEN. See [Opening the jHAVEN Application](#).
2. Select the ‘Change Password’ option from the Security drop down on the toolbar.
3. The ‘Change Password’ screen displays.

4. Enter the current password in the ‘Password’ text field.
5. Enter a new password in the ‘New Password’ text field.
6. Enter the new password again in the ‘Confirm New Password’ text field.

   NOTE: The two passwords must be exact matches and must follow the password rules in the Password Rules section.

7. Click the ‘Change Password’ button.

   NOTE: Clicking the ‘Cancel’ button will not change the password and will end this process.

8. The pop-up window closes and the new password is saved.

Logout

To log out and return to the Welcome screen with the Login pop-up window open, select the Logout option from the Security drop down on the menu bar. The Login window displays. This allows the user to log into the application again.

See the section Closing the Application for all the options and details for leaving the application.

Help

Help documents are available for all data entry fields and assessment questions.
While performing data entry, the help documents can be accessed by clicking on the Help icon to the right of each field/question. After clicking on the Help icon, a pop-up window will display the information describing the field. This feature is available on the Administration Screens. The sample shows the “?” seen on the Agency Screen.

**Help Option from Menu Bar**

Help information can also be accessed by selecting Options from the Help dropdown on the Menu Bar. They are available any time a user is logged into jHAVEN. Available Options for selection are:

- Search
- Help Content
- About Quality Management System
- Home Screen

**Help Search**

1. Select the ‘Search’ option, which allow input of a specific topic in the ‘Search expression’ field.
2. Click on ‘Go’ to initiate a search to locate information on that topic.
3. The system will display all related options.
4. Click on the option most suited.

5. The list of fields associated with the option selected displays. Click on one of the data fields.

6. The definition of the field is displayed.

7. Return to the original options, click on Search.

8. Click on another option.

9. A new data field list displays.
10. Click on the help tab ‘X’ to close the Search Help option.

**Help Contents**

Clicking the bold jHAVEN heading, will display ALL help documents for the most current version of jHAVEN.

Expanding the ‘jHAVEN’ topic and then the ‘jHAVEN Item Help by Timeframe’, on the left, will allow the user to narrow the list down to a more specific set of items. In the sample below, only the documents for Agency Screen display.
jHAVEN Item Help by Timeframe

Contents

- 10.6 - OASIS C
- 0.0 - OASIS C1
- Add Assessment Screen
- Agency Screen
- Branch Screen
- Patient Screen
- User Screen

Agency Screen Item Help

State Assigned Agency ID
Agency Name
Agency Address Line 1
Agency Address Line 2
Agency City
Agency State
Agency Zip Code
Agency Activation Date
Agency Termination Date
National Provider Identifier
NPI
State Provider Number
Agency Contact Person Name
Agency Contact Person Phone Number
Agency Contact Person Phone Number Extension
Branch Information List
Agent Federal Tax ID (6 LN)
Agent Name
Agent Address Line 1
Agent Address Line 2
Agent City
Agent State
Agent Zip Code
Agent Contact Person Name
Agent Contact Person Phone Number
Agent Contact Person Phone Extension
About Quality Management System

Information about the version of jHAVEN currently installed can be found by selecting About Quality Management System from the Help menu.

![About Quality Management System](image)

QIES Help Desk

The QIES Help Desk is available for technical support and assistance with problems or questions that may arise regarding the jHAVEN software.

Contact information for the QIES Help Desk:
1-877-201-4721 or help@qtso.com

Installation Type

This identifies either the Standalone installation or the Client/Server installation.

Feature Verification

Feature Label (jHAVEN) and Feature Version (1.x or 1.x.x) display in the lower left side of the screen. Help Desk Information displays on the right side of the screen.

When the jHAVEN application is accessed and the computer running jHAVEN has an internet connection, the application will compare the version currently installed with the version available on the QIES Technical Support Office (QTSO) website. If a new version of jHAVEN is available, a message will display directing the user to the QTSO website to download the latest version.
Miscellaneous System Maintenance

Passwords

Password Rules

Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:

- The new password and confirm new password must match.
- The new password must be at least eight (8) characters long.
- The new password must be no more than 20 characters long.
- The new password must not contain any space.
- The new password must not contain the User ID, First Name, Last Name, or Email.
- The new password must not begin with a number.
- The new password can only contain a maximum of three (3) repetitive characters.
- The new password must contain at least one for each of the following type of characters.
  - Upper-case Character: A-Z
  - Lower-case Character: a-z
  - Number: 0-9
  - Special Character: - &~'*@ $#%^*()_+={|}\:;''<>,.?/
- The new password must not match any of the user’s most recent six (6) passwords.
- The new password will be set to expire in 60 days.

Forgotten Passwords

Complete the following steps:

1. On the login screen, enter User ID and click the ‘Forgot Password’ button.

2. The ‘Security Questions’ pop-up window displays. It lists three (3) of the six (6) Security questions previously answered: In the sample below the following questions are asked:
   a. What city were you born in?
   b. What is your mother’s maiden name?
   c. What was the color of your first car?

3. Answer the security questions.
4. Click the ‘OK’ button to continue to the Change Password screen.
Locked Accounts

Data Entry User & View Only User Account Locked
The following message will display if a user account becomes locked.

User may either:

• Follow the instruction for [Forgotten Passwords](#) to unlock the account. Security questions must be answered and a new password must be created to continue.

OR

• The System Administrator can reset the account following the steps:

1. The System Administrator must log in.
2. On the User screen, select the user that has a locked account (displays in bold in the User Summary section).
3. On this User screen, check the ‘Reset Password/Unlock The Account’ checkbox.

4. Click the Save icon.
5. The user account is unlocked with the password reset to the User ID.

System Administrator Account Locked
If a System Administrator account becomes locked, the same message will display.

Follow the instructions for [Forgotten Passwords](#) to unlock the account.

Security questions must be answered and a new password must be created to continue.

NOTE: A second System Administrator may log in and reset the account by following the steps as described above.
Help Desk to Unlock Account
If the account cannot be unlocked using one of these options, contact the Help Desk for assistance. See QIES Help Desk. The Help Desk can utilize a secure password reset tool that allows the generic jHAVEN account (used at initial log in) to be reset for the purpose of unlocking the other accounts.

Database Backup and Restore

Database Backup
Database backup occur on automatically on a regular basis.
- See Data Backup on Close for the details of this backup process.
- The jHAVEN application will also automatically back up the database if it is has NOT been backed up in the last 7 days.

Changing the Backup File Location
To change the location used when the jHAVEN database is backed up, use the File Menu dropdown; select ‘Change Backup Location’.

The default location for the backup database is located in a database/backup folder where the application is installed. Only System Administrators may change the location where the backup will be stored.

Complete the following steps to change the location where the backup will be stored.
1. Select the ‘Change Backup File Location’ option from the File drop down from the menu bar.
2. The Change Backup File Location window displays with the current backup location highlighted.
3. Select the desired backup location using the scroll bar
   Or
4. Create a new folder using the ‘Make New Folder’ button.
5. Click ‘OK’ button to set the location and close the screen.

   Note: Click the ‘Cancel’ button to close the window without changing the location of the backup files.

Restore the Database from Backup
In the event of data loss, System Administrators may perform a database restore from a prior database backup.

A database restore requires the assistance of the QIES help desk (1-877-201-4721 or help@qtso.com).

The User must know the verification information before calling the Help Desk. Use the following steps to locate these features.
1. Click the ‘About Quality Management System’ under the Help Menu.
2. The ‘About Quality Management System’ screen displays.

3. Locate the verification features in the lower left-hand corner of the ‘About Quality Management System’ screen.
   a. Installation Type
   b. Feature Label: User Tool Acronym
   c. Feature Version
   d. Feature ID
   e. Build ID

4. Call the QIES help desk (1-877-201-4721 or help@qtso.com).
Network Client/Server Application Instructions

These instructions apply ONLY to the Network Client/Server type of jHAVEN application.

Unlock Client/Server Records

In the Client/Server version of jHAVEN, multiple users access a central database. When this functionality is provided, it is necessary to provide additional safe guards to keep multiple users from trying to open and use the same record all at the same time. The system will lock a record once a user opens it for edit. That user’s User ID will be placed in the ‘Locked’ column in the Assessment Search Summary.

The System Administrator is the only user who can, if necessary, unlock records. They can locate the locked records using one of two methods:

- Use the Assessment Search Screen ‘Unlock Assessment’ button.
- Use the System Administrator Unlock pop-up window.

Unlock using Assessment Search Screen

On the Assessment Search Screen, the assessment records that are locked will have a User ID in the ‘Locked’ column in the summary result.

Complete the following steps to unlock one of the locked assessments.

1. Click the Search button. (May, or maybe, choose to use the search criteria fields.)
2. Locate the locked assessment that requires unlocking.
3. Highlight the desired assessment.

NOTE: It is recommended that the System Administrator communicate with the user who has the assessment locked, if possible, before using the unlock feature.
IMPORTANT NOTE: Only System Administrators have access to this button. It is disabled for all other User Roles. This is only available in the Network Client/Server version of the application.

4. The System Administrator can then click on the ‘Unlock Assessment” button.
5. The Assessment will be unlocked.

Unlocking Records using the Locked Pop-up Window
The System Administrator also has an option, ‘Locked Records’, under the Administration Menu item.

Complete the following steps to unlock one or more of the locked records using the Locked Records screen.
1. Click on the ‘Locked Records’ option in the drop down.
2. The Locked Records pop-up screen displays with the following columns:
   a. Record Type will contain one of the valid values: Agency, User, Patient, Branch or Assessment
   b. Identifier will contain the information required to identify the specific record.
   c. User Id is that of the user who has locked the record.
   d. Lock Date is the date that user locked the record.

3. Locate the locked record(s) that requires unlocking.
4. Check the check boxes for each record to unlock.
   OR
5. If all records listed must be unlocked, click on the ‘Select All’ button.
NOTE: It is recommended that the System Administrator communicate with the user who has the assessment locked, if possible, before using the unlock feature.

6. Click the ‘Unlock’ button.
7. The “Record(s) Unlocked” message displays. “<<Number>> record(s) have been unlocked.”
End of User Guide

for
jHAVEN 1.1.0